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Abstract

loT is a comprehensive subject covering many technological areas. Plenty of information is available
on the Internet, but it is not easy to know where to start to get a basic overview.

Nordic Semiconductor has developed a rich set of components suitable for use in wireless loT
applications. Software development for these are based on the Zephyr Real Time Operating System.
Zephyr includes a comprehensive library of drivers and protocols suitable for use in loT applications
based on Nordic's chips. Lots of documentation and examples are available, but my experience is
that a substantial technological background is required to get a good understanding.

I will in this thesis present basic technologies behind IoT, with special focus on wireless sensor
networks communicating over LTE, based on components from Nordic Semiconductor and the
Zephyr Real Time Operating System.

Simple example programs will be explained and demonstrated, and | will show how | modified an
existing demo application to include my own set of commands to demonstrate two-way LTE
communication between Nordic’s “nRF Cloud” and a development board. | will use development kit
nRF9160dk and Thingy:91 from Nordic during software development and demonstrations.

My hope is that this thesis will give the reader a good starting point for further development of loT
applications based on Zephyr RTOS and components from Nordic Semiconductor.

Sammendrag

loT er et veldig vidt tema med en bratt lzeringskurve, det er hardt 8 komme i gang og det kreves
pagangsmot. Under forprosjektperioden innsa jeg at det finnes fa veiledninger til grunnleggende loT-
programmering med Zephyr RTOS og mikrobrikker fra Nordic. Jeg haper med denne rapporten a
skape en god veiledning (tutorial) for folk som gnsker a sette seg inn i temaet.

Rapporten vil ta for seg loT som begrep og vinkle det inn mot hvordan man benytter ferdige
driverbiblioteker for a bygge tradlgse sensorsystemer som baserer seg pa LTE kommunikasjon.
Systemet vil baseres pa Zephyr RTOS og med mikrobrikker fra Nordic Semiconductor. Jeg vil benytte
nRF9160dk og Thingy:91 under utvikling av programkode. Malet er at en leser skal fa innsikt nok til a
lettere kunne forsta den dokumentasjonen som Nordic selv har skrevet, og dermed kan jobbe frem
mot a utvikle egne loT produkter.

Forord

Oppgaven og problemstillingen er utarbeidet i samarbeid mellom loT laben pa NTNU, Arne Midjo,
Olav Aleksander Myrvang og meg selv, Audun Brabrand. Oppgaven ble omformulert under
forprosjektrapporten da vi fikk litt bedre innblikk i omfanget av et slikt prosjekt. Arne Midjo er min
veileder under prosjektperioden. Nordic Semiconductor har ogsa veert til stor hjelp med veiledning
underveis i prosjektperioden med problemer og utfordringer jeg har stgtt pa. Takk til Anders Storrg,
Erik Robstad og Irene Sollie fra Nordic. | tillegg ma en takk sendes til min far, Tord Brabrand, for
assistanse med JSON parser og korrekturlesning.
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1.  Introduksjon

1.1 Bakgrunn

Jeg har alltid vaert fasinert av kommunikasjon over mobile nettverk, men har ikke hatt tid til 3 sette
meg inn i emnet fgr under denne bacheloren. Jeg fattet derfor raskt interessen for de
bacheloroppgavene som omhandlet 4G/5G kommunikasjon og loT applikasjoner, da de ble publisert
vinteren 2020. Allerede fgr jul startet prosessen med a sette seg inn i denne typen teknologi i Norge.
Telenor var tidlig ute med a bygge ngdvendig infrastruktur for a vaere bransjeledende innen loT
nettverk, det var derfor et logisk sted & starte. | nettbutikken til Telenor finner man Nordic Thingy:91.
Thingy:91 en komplett prototypenhet med batteri, 4G (LTE) modem og en rekke sensorer, utviklet og
designet av Nordic Semiconductor. (1) (2)

Det ble en litt annerledes prosjektperiode grunnet innledende oppstartstrgbbel utenfor min kontroll.
Dette gjorde at jeg endte opp uten gruppe og arbeider dermed alene om a Igse oppgaven. Dette
gjorde ogsa at jeg fikk en viss grad av frihet til 8 formulere oppgaven etter egent gnske. Uten tidligere
erfaring med hverken RTOS programmering eller stgrre software-biblioteker ble det vanskelig a
avgjgre hva som kunne vaere realistisk stgrrelse pa en slik oppgave. De fgrste utkastene til oppgaver
ble dermed for ambisigse og den endelige formuleringen kom frem mot slutten av
forprosjektperioden. Oppgaven er utformet i samarbeid mellom loT laben pa NTNU, Arne Midjo og
meg selv. Vi fikk innspill fra Nordic Semiconductor angaende Bluetooth som gjorde at hovedfokuset
blir rettet mer mot kommunikasjon over LTE nettverk.

Rapporten skal gi et godt grunnlag for a forsta hva loT er og hvordan man utvikler egne loT
applikasjoner basert pa systemene til Nordic. Det fordrer at man har grunnleggende kunnskaper om
C programmering samt pagangsmot for a fa fullt utbytte av denne rapporten.

1.2 Problemstilling
Etter a ha justert ambisjonsnivaet for oppgaven et par ganger kom vi omsider frem til en
problemstilling som lyder slik:

"Innhente og bygge kunnskap for G forsta hvordan man pa en effektiv og praktiske mate kan utvikle
og implementere loT-Igsninger i eksisterende og fremtidige systemer. Prosessen skal resultere i en
rapport som fremtidige studenter kan ha nytte av for @ raskere sette seg inn i loT-universet og
benytte chiper fra Nordic Semiconductor i sine egne Igsninger." (3)

1.3 Resultatmal

Prosjektets resultatmal ble ogsa justert etter ambisjonsnivaet underveis, fra @ bedgmme
funksjonaliteten til et ferdig system legger vi i stedet mer vekt pa innholdet i rapporten. Fra
prosjektmanualen har vi at "Resultatmdlet beskriver hva som konkret skal foreligge som resultat ndr
prosjektet er ferdig". (4)



Produktets kvaliteter

e Selvforklarende og pedagogisk

e Rett pa sak med relevant informasjon om det tema man til enhver tid snakker om.
e Mye eksempler og forklaringer pa hva eksemplene tar for seg

e Bygge opp systemet bit for bit sa man skaffer seg oversikt underveis

e Gjgre systemet utvidbart med mange bruksomrader

e Legge opp til videre etterarbeid

De nye resultatmalene er rettet mer mot a gjgre rapporten oversiktlig og pedagogisk. Dette skal
bidra til 3 gi leseren motivasjon og ideer til et etterarbeid. Etter avtale med veileder Arne Midjo har
jeg gatt noe bort fra den klassiske oppbygningen av en bachelorrapport for nettopp a gi den flyten
man trenger for a sette seg inn i stoffet.

1.4  Disposisjon

For a gj@re rapporten sa lettlest som mulig far leseren presentert relevant teori i en rekkefglge som
gir mening i forhold til flyten i prosjektet. Oppbygningen er basert pa mine erfaringer underveis i
prosjektet i et nytt utviklingsmiljg. Underveis i rapporten vil det ogsa bli henvist til artikler og
nettsider som ble ansett som gode kilder til informasjon. Det vil veere nyttig og ta for seg disse
underveis i gjennomlesningen for a til enhver tid ha best mulig oversikt over tema. Henvisninger i
klammeparentes er ansett som nyttige dersom man vil lese mer om et tema, men de er ikke
ngdvendig for forstaelsen av innholdet i rapporten.

Siden en viktig del av denne rapporten er a veere pedagogisk vil metode og teori bli noe blandet. Det
vil veere gunstig a presentere teori for sa a vise hvordan det skal brukes. Den vil allikevel begynne
med en introduksjon og forklaring pa hva loT er og hvem Nordic Semiconductors er. Vi vil i kapittel 3
ga narmere inn pa detaljene i et typisk loT system.

Videre vil resultater og diskusjon bli sydd noe sammen med mine erfaringer. Avslutningsvis trekker
jeg frem flere temaer det vil vaere aktuelt a se videre pa, og hva som kan veere interessant a jobbe
videre med som etterarbeid. Etter et slikt prosjekt vil det alltid vaere mange Igse trader man kan
ngste videre i for a skaffe seg mer og bredere kunnskap om et slikt fagfelt.



2. Teorli

2.1  HvaerloT?

Internet of Things har kommet opp som et begrep for enheter som er koblet pa internett og som
samhandler uten 3 aktivt matte styres av en bruker. Alle enheter har sin unike ID og kan aksesseres
individuelt. Ofte vil man ha behov for a kunne koble flere enheter sammen i et lokalt nettverk for &
utfgre gitte oppgaver, slike enheter er typisk sensorer og aktuator. Eksempel pa bruksomrade kan
vaere temperaturstyring av en hall. Her vil man da kunne ha flere temperatursensorer rundt om som
kommuniserer med varmeapparatet for 3 opprettholde en jevn og god temperatur i lokalet. (5)

Til tross for at systemet normalt ikke har behov for interaksjon med et menneske er det ofte
ngdvendig fgrste gang systemet skal konfigureres. Konfigurasjonen foregar stort sett over et web-
grensesnitt via en web-server. Avhengig av design vil man ogsa kunne fglge driften av systemet i
sanntid, lese av sensordata, sjekke status pa aktuatoren og lese feilmeldinger. Flyten i et slikt system
er vist i figur 1.

1
1
loT applikasjon Publish
Sensorer +—»{ "on the Edge"
(temp, lys, fuktighet) (ink. modem)

Gjer noe MQTT Broker
(skru pa ovnen) loT applikasjon | Subscribe loT Applikasjon
"on the Edge" [@——
o s
Gjar noe
- —
(skru pa lyset)
Gjgr noe > Webside
- -— (nettleser)
(skru av alarmen)
> Mobil-app
Figur 1 —lllustrasjon loT nettverk (handholdt enhet)

Til et tenkt bruksomradet har vi behov for en rekke sensorer. Disse sensorene er plassert der det er
gunstig med tanke pa hva de skal male. Sensorene er innenfor Bluetooth-rekkevidde til hverandre,
dette gj@r det mulig a benytte Bluetooth som kommunikasjonskanal mellom dem. Sensorene snakker
i sin tur med en sentral som gjgr en viss grad av datahandtering direkte, dette kallers prosessering
"on the edge". Denne sentralen kommuniserer igjen med en web-server via mobilt internett. P3
webserveren har man programvare for MQTT Broker som behandler meldingsflyten i systemet, samt
en loT Applikasjonsserver som tar seg av oppsett og funksjonalitet ved systemet. En bruker kan
aksessere web-serveren via en nettlgsning, ofte en nettside. | dette nettverket vil det vaere en flyt av
"Publish" og "Subscribe" meldinger som forteller hva dataene som transporteres gjelder. Vi vil snakke
mer om dette i kapittel 4.



2.2 Hvem er Nordic Semiconductor?

Nordic Semiconductor, heretter kalt Nordic, ble etablert i Trondheim i 1983 av fire studenter fra
NTNU. Firmaet har spesialisert seg pa laveffekt mikrobrikker for tradlgse applikasjoner. Brikkene er
brukt i en rekke tradlgse produkter, deriblant mus og tastaturer fra Logitech og Microsoft. | 2018 ble
det lansert en SiP (System-in-Package) med LTE-modem og GPS mottaker rettet mot loT markedet,
og i disse dager lanserer de en ny mikrobrikke med WiFi stgtte. Kombinert med de allerede
eksisterende Bluetooth brikkene har de na alt som skal til for & utvikle komplette loT Igsninger.
Nordic har ogsa utviklet et komplett driverbibliotek for mikrobrikkene sine med grensesnitt mot
Zephyr RTOS. (6)

Siden oppstarten har Nordic ekspandert med over tusen ansatte og med kontorer i minst ni land. (7)

2.3 Thingy serien

Nordic har designet en rekke utviklingskort og
prototypplattformer, deriblant Nordic Thingy:91 og Thingy:52
som gjenspeiler mikroprosessorene nRF9160 og nRF52832.
Begge disse prototypplattformene har en rekke sensorer for
bevegelse og luftkvalitet. Thingy:91 er utstyrt med LTE modem
for NB-1oT og LTE-M, samt Bluetooth Low Energy (BLE) og GPS
mottaker. Thingy:52 stgtter derimot ikke LTE eller GPS, men er i
stedet utstyrt med noen ekstra sensorer. Thingy kortene er best
egnet til Proof-of-Concept da disse ikke har innebygget Figur 2 —Thingy:91
debugger. De har derimot et kompakt design med

Li-Po batteri. (8) (9)

Utviklingskortene nRF9160dk og nRF52840dk har J-Link debugger som gj@r det kjapt og enkelt a laste
kode, samt feilsgking under utvikling av programvare. Programvarekoden man designer for et kort
kan enkelt flyttes over til 3 ga pa annen hardware, gitt at hardwaren har tilsvarende funksjonalitet.
Utviklingskortene har ikke innebygde sensorer, de tilbyr kun simulerte verdier for sensorene.

2.4 NRF9160

nRF9160 har da altsa innebygget LTE modem kombinert med
GPS og en applikasjonsprosessor. Prosessoren er en 32 bit
ARM Cortex — M33 pa 64MHz med 1MB flash og 256kB RAM.
Av I/0 kan man nevne 12bit ADC, RTC (Real Time Clock), SPI,
I2C, UART, PWM modulator med mer. Chipen har 32 GPIO-
pinner. Modemet stgtter NB-loT og LTE-M med TCP/UDP og
TLS sikkerhet. nRF9160 har ikke Bluetooth. (10) (11) (12)

2.5 NRF52 serien

nRF52840 er en SoC beregnet til lokale loT oppgaver over
BLE, mikrokontrolleren er basert pa en ARM Cortex — M4F
prosessor med tilsvarende egenskaper som den brukt i nRF9160. Det finnes
mange utgaver av denne serien med SoCer, nRF52832 er en enklere utgave
med mindre minne og faerre GPIO pinner. Disse mikrobrikkene stgtter et bredt
utvalg av tradlgse standarder i 2.4GHz spekteret, deriblant Bluetooth MESH,
Thread, Zigbee, ANT med mer. Ved a kombinere denne med nRF9160 vil man
kunne utvikle komplekse systemer med bade LTE, GPS og BLE. (13) (14) Figur 4 —nRF52840 SoC

Figur 3 —nRF9160 SiP
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2.6 Programvareverktgy

Nordic har lagt opp til at man benytter SEGGER Embedded Studio til utvikling av programkode for
mikrobrikkene deres. SEGGER er gratis for personlig bruk, samt for utvikling av kode til enkelte
mikrobrikker. Alle brikkene til Nordic er inkludert i denne ordningen. SEGGER kan installeres pa
plattformene Windows, Linux og Mac. (15)

Nordic tilbyr en rekke hjelpemidler for utvikling av IoT enheter, disse tingene er samlet i programmet
nRF Connect. Her finner man blant annet LTE Link Monitor, Bluetooth Low Energy verktay,
Programmerings-verktgy, Power Profiler og Toolchain Manager. Toolchain Manager er SEGGER,
programmet lastes ned og installeres direkte fra nRF Connect. Inkludert i denne nedlastingen er ogsa
demoprosjekter og driverkode for de aktuelle utviklingskortene for denne rapporten. (16)

| neste kapittel vil vi ha behov for nRF Connect og SEGGER Embedded Studio (Toolchain Manager),
start gjerne nedlasting og installasjon av dette allerede na.

Versjonen jeg har brukt er nRF Connect SDK v1.5.1.

nRF Connect: https://www.nordicsemi.com/Products/Development-tools/nrf-connect-for-desktop
Merk: "Knapp" for nedlasting er teksten "nrfconnect-setup-3.7.0-ia32.exe".

2.7  Zephyr RTOS

I loT sammenheng begynner systemene a bli sapass komplekse at det er ngdvendig med en form for
RTOS (Real Time Operating System). Tanken bak et slikt system er a fordele prosessortid pa flere
prosesser som naermest kan ga i parallell. | Zephyr kalles slike prosesser for Threads. Nar man jobber
med sanntidssystemer, typisk ting som er koblet i nettverk, er det viktig at prosessoren ikke blir
staende med en oppgave i lengre tid. Tenk pa det som multi-tasking. Dersom du vil laere mer om
sanntidsprogrammering kan det leses her: (17)

Nordic har lagt opp til 8 benytte Zephyr OS som operativsystem. Zephyr Project er del av The Linux
Foundation og utvikles i samarbeid med flere store aktgrer. Det er lagt opp til at systemet skal vaere
skalerbart etter hva man har behov for. Zephyr OS, samt FreeRTOS, er blant de meste brukte apen-
kildekodesystemene for bruk i loT sammenheng. (18) (19) (20)

2.8  Dokumentasjon
Nordic har gjort en omfattende jobb med a dokumentere produktene sine, dokumentasjonen er delt
inn i tre hoveddeler.

o Infosenter — oversikt over dokumentasjon, hardware og diverse revisjoner.
URL: https://infocenter.nordicsemi.com

e nRF Connect SDK — oversikt over utviklingsverktgy, programvarebiblioteker og drivere.
Merk: Nederst pa venstre side kan man bytte mellom ulike deler av denne dokumentasjonen.
URL: https://developer.nordicsemi.com/nRF_Connect SDK/doc/latest/nrf/index.html

e DevZone —forum med guider og muligheter for diskusjon.
Merk: Nybegynnerguider finnes i menyen under "Nordic content" -> "nRF Connect SDK guides".
URL: https://devzone.nordicsemi.com/

o Dokumentasjon for Zephyr finnes her:
URL: https://docs.zephyrproject.org



https://www.nordicsemi.com/Products/Development-tools/nrf-connect-for-desktop
https://infocenter.nordicsemi.com/
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3. Kode - Grunnleggende

Vi vil nd begynne a se pa hvordan vi kan utvikle egen programvare til Bootioader
mikrobrikkene. For 3 gjgre dette pa en effektiv mate er det viktig a forsta
oppbygningen av koden som Nordic allerede har utviklet. For a forsta de
grunnleggende tingene starter vi med eksempelprosjektet "Threads". Vi Sec;ﬂr:r‘z:g::ition
skal straks se pa hva threads er og hvordan det brukes.

ainosg

Det er na forventet at nRF Connect og SEGGER (Toolchain Manager) er
installert. For a hente frem eksempelprosjekter finner man disse under
"Files" ->"Open nRF Connect SDK Project...". Her finner man blant annet
prosjektet "Threads" og kortet "nrf9160dk_nrf9160ns".

Application

2inJ3s-UON

Prosessorkjernen for applikasjoner (MCU) er i dette tilfellet Cortex-M33 i
nRF9160. Den er delt inn i to deler, en sikker og en usikker del.
Programvaren vi designer skal kjgres i den usikre delen, derav navnet Modem Library
nrf9160ns. (21) Se figur 5. For a lese mer om dette, besgk siden:
https://developer.nordicsemi.com/nRF_Connect SDK/doc/latest/nrf/
ug nrf9160.html#available-drivers-libraries-and-samples.

Prosjektet "minimal" er et tomt prosjekt som er egnet for a teste ut LTE modem
kodesnutter underveis. Prosjektet inneholder en del grunnleggende
konfigurering og selvfglgelig Zephyr RTOS. Nar man apner et slikt Figur 5 —nRF9160 arkitektur

prosjekt redigerer man direkte i de kodefilene som ble lastet ned i
forbindelse med installasjon. Det kan by pa utfordringer a finne igjen de
opprinnelige filene, det er dermed lurt a ta en kopi av de prosjektene du
har planer om a redigere. Ved a hgyreklikke pa "main.c" kan man dpne
mappa i Windows filutforsker. Se figur 6.
4 7] solution “build’

[g Project all

a M Project ‘app/libapp.a’
4 3 C_COMPILER_ app_
+ E:j main.c

¥ g Cutput Files
3.1 Threads Figur 6 — Filstruktur
En trad (thread) er et objekt i Zephyr kjernen som blir brukt for a
utfgre prosesser som er for lange og komplekse til 3 bli utfgrt av et interrupt. Hver thread far tildelt
sitt omrade i arbeidsminne (RAM), mengden RAM avgjgr hvor mange threads et system kan
handtere. | sanntidssystemer gar prosesser i parallell, de prosessene vi skal designe skrives i form av
funksjoner. Nar man gnsker kjgrt en slik funksjon velger man hvordan den skal kalles. Den kan enten
kalles via en thread, fra workqueue eller den kan kalles fra main-lgkka. Workqueue brukes for
prosesser som ikke haster, det er en egen thread som tar unna elementene som ligger i workqueue.
Main-lgkka har den hgyeste prioriteten i systemet, prioritet 0. (22)

Det kan ogsa vaere praktisk a apne kodefiler i Notepad++ dersom
du har behov for a se pa kode utenfor det prosjektet du jobber i.
SEGGER kan bare operere med et prosjekt av gangen.

Les mer her:

e Threads: docs.zephyrproject.org/latest/reference/kernel/threads/index.html
e Workqueue: docs.zephyrproject.org/latest/reference/kernel/threads/workqueue.html
e Scheduling: docs.zephyrproject.org/latest/reference/kernel/scheduling/index.html
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3.1.1 Opprette en thread

Nar en thread skal deklareres velger man en passende stgrrelse pa arbeidsminne (STACKSIZE) og
hvilken prioritet den skal kjgres i. Selve deklarasjonen er en enkelt kodelinje, K_THREAD_DEFINE(...).
Figur 7 viser all kode som trengs for a deklarer og kjgre en thread i Zephyr RTOS. Rutinen
k_msleep(...) legger den aktuelle threaden i dvale i en gitt tid. Hele systemet kan legges i dvale
dersom det ikke er andre threads som kjgres.

i Thread ----- )
#include <zephyr.h:

fF aaae- Constants ----- *f
#define STACKSIZE l1e824
#define PRIORITY 7

J*¥ - Function ----- *f
void printk_funk({void)
1
while(1)
1
printk({"Thread is running “n");
k_msleep(s@aa);
¥
¥

f*F - Define Thread ----- *f
K_THREAD DEFINE(funk id, STACKSIZE, printk_funk,
NULL, NULL, NULL, PRIORITY, @, @);

Figur 7 — Deklarere en thread

Det kan ofte vaere lurt 3 lese mer om en forhandsdefinert makro, dette gjgres ved a hgyreklikke pa
den og velge "Go To Definition". Vi ser i figur 8 at makroen skal ha 9 inngangsparametere.
Kommentarene gir en god pekepinn pa hvordan makroen er ment a brukes.

* [@param name Name of the thread.
* [param stack size Stack size in bytes.
* flparam entry Thread entry function.
* @param pl 1lst entry point parameter.
* @param p2 2nd entry point parameter.
* @param p3 3rd entry point parameter.
* [@param pric Thread priority.
* [@param ocptions Thread options.
* ([@param delay Scheduling delay (in milliseconds), zero for no delay.
E
fdefine K_THREAD DEFINE(name, stack_size,
entry, pl, p2, p3,
pric, options, delay)
K_THREAD STACK _DEFINE(_ k_thread_stack_##name, stack_size);
struct k_thread _k_thread_cbj_ ##name;
Z_ STRUCT_SECTION ITERABLE( static_thread data, k thread data_ ##name) =%

P

Z_THREAD INITIALIZER(& k thread obj ##name, A
_k thread stack ##name, stack size, A
entry, pl, p2, p3, pric, opticns, delay, 7
NULL, name); kY

const k_tid t name = (k_tid_t)& k thread_obj_##name

Figur 8 —"Go to definition"



3.1.2 Workqueue

En workqueue er en FIFO (first-in-first-out) liste over jobber man gnsker utfgrt. Workqueue benytter
en egen dedikert thread for a fa utfgrt disse jobbene. Threaden har vanligvis lavere prioritet enn
andre threads i systemet. Vanligvis brukes workqueue i sammenheng med ISR (Interrupt Service
Routine) eller en hgy prioritets thread der man ikke har tid til 3 gjgre prosesseringen umiddelbart.
Som med threads definerer man stgrrelsen pa arbeidsminne og hvilken prioritet man gnsker. (23)
(24)

Videre blir disse to strukturene definert:

struct k_work  er for arbeidselementet som skal legges i kgen (25)
struct k_work_q definerer selve kgen som workqueue bruker (26)

Deretter starter man workqueue prosessene:

k_work_init initialiserer workqueuen for funksjonen print_workqueue.
k_work_gq_start starter workqueuen

k_work_submit legger arbeidselementet til i workqueue kgen.
k_msleep(2500) setter systemet i dvale i 2500ms.

A Workqueue ----- */
#include <zephyr.h:

fFoaeee- Constants ----- *f
#define STACKSIZE 512
#define PRIORITY 5

K_THREAD STACK DEFINE(stackarea, STACKSIZE);

f¥ e Function ----- */
void print_workqueue(struct k_work *work)
1
printk("vWorkqueus is running “n"};
h
void main{void)
1
A Workqueue ----- */
struct k_work work;
struct k work_g my_work _gq;
k_work_init{&work, print_workqueue);
k_work_q_start(&my_work_q, stackarea, /*New-line*®/
K_THREAD STACK SIZEOF(stackarea), PRIORITY);
while(1)
1
k_work submit(8work); //Add item to workgueue
k_msleep(2582);
b
¥

Figur 9 — Workqueue



3.1.3 Styre LEDs

Videre ser vi pa hvordan en lysdiode konfigureres, det vil her veere LED1 pa kortet som blinker med
en frekvens pa 1Hz. Det ma inkluderes driver for GPIO samt Devicetree for dette prosjektet.
Devicetree (DT) er en datastruktur over hardware som operativsystemet bruker for a tilpasse seg den
hardwaren det kjgrer pa. Dette gjgr at koden du programmerer kan kjgres pa forskjellige hardware-
konfigurasjoner. Det er gjerne produsenten av hardwaren som generer DT-filene. (27) (28) (29)

T e Blinky ----- *f

#include <zephyr.h>
#include <devicetree.h>
#include <drivers/gpioc.h>

//Devicetree node identifier for the "led®" alias
ffled@ in DT is LED1 on the board
#define LED1_NODE DT_ALIAS(led@)

J//Check and configure of ledl.

#if DT_NODE_HAS STATUS(LED1 NODE, ckay)

#define LED1 DT_GPIO LABEL(LED1 NODE, gpios)
#define PIN DT_GPIO PIN(LED1_NODE, gpios)
#define FLAGS DT_GPIO FLAGS{LED1 NODE, gpios)

void main{wvoid)

1

}

const struct device *dev;
bool led is on = true;
int ret;

dev = device get binding(LED1);
if (dev == NULL)} //Error check
return;

ret = gpio pin_configure(dev, PIN, GPIO OUTPUT ACTIVE | FLAGS);
if (ret < @) //Error check
return;

while (1)
1

gpio_pin_set(dev, PIN, (int)led_is on);
led is on = !led_is_on;

k_msleep(5aa);

Figur 10 — Blinky

Figur 10 viser ngdvendig kode for & blinke med en lysdiode. Linje 8 viser hvordan man bruker
devicetree for a hente node-id til led0. Videre er linje 11 til 18 for a verifisere at det er funnet gyldig
node-id og for a konfigurere lysdioden med rett pinout i forhold til hardware koden kjgrer pa. Sa
brukes device_get_binding() for a gi en peker til objektet vi gnsker a kontrollere, LED1. Linje 30
konfigurerer pinnen som utgang og setter den hgy (aktiv). gpio_pin_set() setter verdi pa utgangen,
denne vil skru lysdioden av og pa annenhver gang i dette eksempelet.



3.1.4 Oppsummering

Vi samler na de tre kodesnuttende i et felles prosjekt og ser hvordan det virker. For a ikke rote til
demoprosjektene bruker vi prosjektet "Minimal". Bygg na prosjektet og se at kompileringen gar
gjennom uten feil. For & laste kode pa kortet gar du til "Target" -> "Download zephyr/zephyr.elf".

For a se utskriftene i terminalvinduet gar du til "Tools" -> "Terminal Emulator". Sett "Baud Rate" til
11520 og prav deg frem til hvilken COM-port som gjelder for ditt system. nRF9160dk har 3 UART
grensesnitt giennom virtuelle COM-porter. To porter til NRF9160 og en til nRF52840. B 3 A
Terminalvinduet dukker opp med et telefonikon i vinduet nederst pa skjermen. (30)

| figur 12 ser vi resultatet av sammenslaingen. Dette er pa ingen mate ideell kode da det blant annet
er lagt en uendelig lgkke i workqueue. Dette vil oppta kgen og hindre eventuelle andre elementer fra
a kjgre. Allikevel gir det en god indikasjon pa hvordan et enkelt prosjekt kan se ut. Vi har 3 prosesser
som gar i parallell. Merk at denne koden har "while(1)" pa tre forskjellige steder, og alle prosessene
gar uansett.

| figur 11 ser vi utskrift fra terminalvindu. Dette er ~ Workqueue is running
en god illustrasjon pa hvordan kode kjgres i et Thread is runniWorkqueue is running
RTOS. Prosessene gar i parallell og dette fgrer til at ':lEr"k_queue is running
de kan ga i beina pa hverandre. Vi ser at utskriften  Thread is running Workqueue is running
fra Threads blir avbrutt for a kjgre Workqueue, og
I Workqueue is running
motsatt. | komplekse applikasjoner kan denne Thread is running
typen feil vaere omtrent umulig a finne ut av i Workqueue is running
ettertid. Det er viktig & tenke ngye gjennom hvilke  Workqueue is running
prosesser som kan skape utfordringer dersom de Thread is running
blir avbrutt. En vanlig tabbe er prosesser som Figur 11— Fra terminal
leser/skriver til samme minneomrade. For a
handtere slike problemstillinger kan man benytte
semaforer, spinlock eller deaktivere interrupt.
Dette vil vi komme tilbake til i et senere kapittel,
men du kan ogsa lese om det her:
https://www.geeksforgeeks.org/g-fact-70/
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1 /* ————- Understand the basics ----- */
? #include <zephyr.h:

#include <devicetree.h:>

4 #include <drivers/gpio.h>

B f* ----- Constants ----- */

7 #define STACKSIZE_thread 1824
¢ #define PRIORITY_ thread 7

9 #define STACKSIZE_work_gq 512
18 #define PRIORITY work_q 5

17 K_THREAD STACK_DEFINE(stackarea, STACKSIZE work_g);

14 /* ----- Blinky ----- */

15 //Devicetree node identifier for the "led®" alias
16 //led® in DT is LED1 on the board

17 #define LED1_NODE DT_ALIAS(ledd)

19 //Check and configure of ledl.

26 #if DT_NODE_HAS_STATUS{LEDL_NODE, okay)

21 #define LEDL  DT_GPIO_LABEL(LEDL_NODE, gpios)
22 #define PIN DT_GPIO_PIN(LED1_NODE, gpios)
23 #define FLAGS  DT_GPIO_FLAGS(LEDL_NODE, gpios)

29 [* ----—- Functions ----- */
void print_thread(void)

1
32 while(1)

4 printk("Thread is running \n"};
35 k_msleep(5@82);

S

37}

29 wvoid print_workqueve(struct k_work *work)
48 {

41 while(1)

43 printk("workqueue is running \n");
44 k_msleep(25@8);

45 1

a4g J* --—--- pDefine Thread ----- *J

/* _______________________________ */
2 /¥ e Main-loop ---------- */
3 /* _______________________________ */
4 woid main{wvoid)

5 {
T e Workqueue ----- */

struct k_work work;
struct k_work_q my_work _q;
k_work_init({&work, print_workgqueue);

¥, k_work_submit(&work); //Add item to workgqueue

N e Blinky ----- =/
const struct device *dev;
bool led_is_on = true;
int ret;

als dev = device_get binding(LED1);
7@ if (dev == NULL)} //Error check
1 return;

73 ret = gpio_pin_configure(dev, PIN, GPIO_OUTPUT_ACTIVE
74 if (ret <« @) //Error check

7 return;

77 while{1)

78 [

79 gpio_pin_set(dev, PIN, (int)led_is_on);
B led_is on = !led is_on;

21 k_msleep(5&a);

2 )

“ )
Figur 12 — Understanding the basics

9 K_THREAD DEFINE(funk id, STACKSIZE thread, print thread, NULL, NULL, NULL, PRIORITY thread, @,

k_work_q_start(&my work g, stackarea, K_THREAD STACK SIZEOF (stackarea), PRIORITY work_q);

| FLAGS);

@);
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4.  Kode — Opprette forbindelse til sky

Vi vil nd begynne a se pa hvordan man kommuniserer med en skytjeneste. Vi starter med a snakke
litt om temaet og hvordan Nordic har sett for seg at det skal gjgres i deres eksempler. Videre ser vi pa
koden i eksempelet "cloud_client" for "nrf9160dk _nrf9160ns". Vi vil sa utvide koden slik at vi kan
styre utviklingskortet fra en nettleser via internett og NB-loT standarden.

NB-loT (Narrowband Internet of Things) er en av protokollene innenfor LTE standarden. Det er
utviklet for systemer som er stremgjerrige og ikke har krav til hgy bandbredde. Maks hastighet over
NB-loT er 127kbit/s for nedlasting og 159kbit/s i opplasting over halv duplex. Det kan ogsa vaere en
betydelig forsinkelse pa opptil 10 sekunder. For applikasjoner som krever hgyere bandbredde kan
man benytte LTE-M. Fordelene her er mye lavere forsinkelse og mulighet for taleoverfgring. (31) (32)
(33)

NB-loT gj@r det mulig a utvikle kostnadseffektive enheter som kan holdes aktive over lange
tidsintervall ved hjelp av batteri og/eller energihgsting. Protokollen stgtter PSM (Power Saving
Mode) som blant annet tillater a holde en forbindelse aktiv selv om den tilkoblede enheten ligger i
dvale. Enheten kan vakne opp, sende en melding for sa a legge seg i dvale igjen, dette uten § matte
opprette en ny forbindelse med basestasjonen. Det vil ikke vaere mulig a sende data til enheten nar
den er i dvale, men dersom basestasjonen stgtter det kan den i midlertid mellomlagre meldingen sa
enheten kan hente dem nar den er vaken. Ved relevant etterarbeid kan jeg anbefale a lese mer om
NB-loT standarden her (34).

I mange tilfeller er det gunstig a bruke MQTT (Message Queueing Telemetry Transport) for
dataoverfgring i NB-loT nettverk, dette er saerlig fordi MQTT krever sveert liten header til
dataoverfgringen. MQTT kan klare seg med kun 2 byte i motsetning til http som trenger 26 byte. Som
med alle protokollene i applikasjonslaget kreves det en underliggende kommunikasjonskanal, MQTT
krever at det benyttes TCP/IP ut pa internett. Dersom det er behov for oppfriskning av
sammenhengen mellom de ulike lagene i et datanettverk kan det leses mer om OSI modellen i
kapittelet "Kjekt G vite" mot slutten av rapporten.

Bluetooth: oo
Thingy:91

Publish / Subscribe

~ MQTT Broker N
» B |oT Applikasjon ~g
~

Thingy:52

Webside
(nRF Cloud)

Figur 13 —1oT med Nordic Semiconductor
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For dette prosjektet vil vi benytte skylgsning fra Nordic Semiconductor. Nordic designet nRF Cloud
for & illustrere funksjonaliteten til prosjektet "asset_tracker" (35) pa en god mate. Dette gikk
dessverre ut over tilpasningsmulighetene, og gjgr tjenesten lite anvendelig for bruk i andre
sammenhenger. Vi kommer hovedsakelig til 8 benytte terminalvinduet for & illustrere
kommunikasjonen i vart prosjekt. Skylgsningen er basert pa Amazon Web Services (AWS) som er mye
brukt i loT sammenheng. Du kan lese mer om AWS loT her (36) (37).

For 8 komme i gang med nRF Cloud ma du opprette en bruker. Nar du sa har fatt logget deg inn ma
utviklingskort og SIM-kort registreres pa brukeren. Guide for dette finnes her: nrfcloud.com og
eventuelt videoguide her https://youtu.be/rMvW3HXLErk?t=575 (YouTube kanalen til Nordic).

Figur 13 viser hvordan man kan se for seg et loT sensornettverk basert pa prototypenheter fra
Nordic. Her vil man benytte Thingy:52 som noder i nettverket som kommuniserer med en sentral,
Thingy:91, som igjen kommuniserer med en web server over NB-loT over internett. Jeg kommer ikke
til & ta for meg nodene i denne rapporten, fokus her ligger pd kommunikasjon fra nRF9160dk
(Thingy:91) til nRF Cloud.

4.1  MQTT og JSON
Kommunikasjonen som gar mellom sentralen 1 {
og nRF Cloud er MQTT meldinger. Det er krav - %

om at nyttelasten i disse meldingene er pd _ T ‘ —
JSON-format. JSON (JavaScript Object Notation) 5

"guests":i [

r
"name" @ "Anders",

er mye brukt i web-applikasjoner for a overfgre g "phone": "4&7-38-522",
data i tekst-format. En av fordelene med JSON T "date" : "2021-07-01"
fremfor XML er at det er plassbesparende. Der g b

XML har dobbelt sett med start- og slutt- . - f - )

notasjoner har JSON bare start-notasjon. Med 11 n;;rr_e " rlé:'_E:-._drl ,
andre ord sparer man bandbredde ved 3 12 "phone": "937-56-0417,
benytte JSON. 13 "date™ : "2021-07-02"
Stgttede datatyper er blant annet tekst, tall, 15 [ {

boolske verdier og tabeller. Data separeres med  ~°© tidToor 5,

17 "name"™ @ "Fredrik",

komma, krgllparenteser brukes for & avgrense ) - - =g91_€9-D0T7"
14 none™ . 1- it 11N

objekter og klammeparenteser brukes for array. - ndate™ : "2021-07-03" ’

Et eksempel pa datastruktur er vist i figur 14. 2 -

Figur 14 —JSON
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MQTT protokollen ble utviklet i 1999 for a veere en enkel og strsmbesparende protokoll som kunne
brukes over nettverk med lav bandbredde. Den ble fgrst tatt i bruk for a overvake rgrledninger i olje-
og gassindustrien. Protokollen har i senere tid blitt sett svaert praktisk i M2M og loT sammenhenger
pa grunn av sine fordeler med stgtte for mange sensorer over en nettlinje med lav bandbredde. |
utgangspunktet er MQTT protokollen er avhengig av TCP/IP protokollen, men en utvidelse kalt
MQTT-SN (MQTT for Sensor Networks) gjgr det mulig a8 benytte Bluetooth som transmisjonsmedium.
(38) (39) (40)

| et MQTT nettverk har man noen sentrale begreper som det er viktig a forsta, se figur 15 i
sammenheng med fglgende liste.

e Klient: Publish/Subscribe — Sender eller mottar data

e Server: MQTT Broker — Mottar data fra klienter og sender videre ut til alle som lytter
e Emne/type data: Topics — Hvor data skal publiseres eller hvor du skal lytte

e Meldinger: Messages — Nytteverdien i dataene som gar pa linja (Payload)

MQTT Broker opptrer som en server. Ute i nettverket har man et antall klienter som sender data til
serveren. Klientene kan abonnere pa forskjellig typer informasjon, pad denne maten kan serveren
sende ut en melding til mange klienter samtidig. MQTT Broker har ansvaret for 8 motta alle
meldinger, behandle dem og publisere i riktig topics.

Meldingene skal ha en definert QoS (Quality of service), det vil si hvordan man skal forsikre seg om at
meldingen blir mottatt. Valgene man har er: Maks en gang, minst en gang eller ngyaktig en gang.
Serveren kan ogsa mellomlagre den siste meldingen den mottok fra en klient for 8 ha mulighet til 3
sende denne til andre enheter som kobler seg pa i ettertid. Man kan ogsa definere hva som skal skje
dersom en klient dgr. For a forsta QoS bedre vil jeg anbefale a ta en kjapp titt her: (41)

Last Will og Testament er forklart her: (42)

Topics forteller hvordan du gnsker at data skal registreres i systemet, hvordan data sorteres er
avhengig av hvordan det er praktisk a sortere dem. | et hus har man typisk flere sensorer i hvert rom
og en felles sentral, fra sentralen gnsker man a skaffe oversikt over disse sensordataene. Fra
sentralen kan man ogsa ha gnske om a skru alt lys av eller pa. Sensorene kan da typisk sorteres etter
rom i huset. Merk at topics er case-sensitiv, det er forskjell pa a skrive OFFICE og office!

home/kitchen/light | home/kitchen/temperature
home/office/ light | home/office/ temperature

@nsker man a fa alle temperaturer i systemet kan man benytte " # " som universaltegn
home/#/temperature

Du kan lese mer om MQTT her:

e https://thenewstack.io/mqtt-protocol-iot/
e https://randomnerdtutorials.com/what-is-mqtt-and-how-it-works/
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Topic: “hom_e{tgmperaturefinside“ Topic: "home/temperaturefinside”

Subscriber

—b B
Temp inne

Publisher

Temp inne

Topic: "homeftemperature/# "

- »  MQTT Broker - Subscriber
: Temp inne og ute

Topic: "homel/temperature/outside” . -
Topic: "homeftemperature/outside”

Subscriber
Temp ute

Y

! Publisher

Temp ute

Topic: "homeftemperature/inside”

Publish/Subscribe
Tempinne

Figur 15 — MQTT forklart

4.2  Cloud_client

Apne na "cloud_client" for "nrf9160dk _nrf9160ns" fra "File" -> "Open nRF Connect SDK Project...". Det
er en feil i dette prosjektet som gjgr at det ikke er mulig & kompilere. Feilen er diskutert i DevZone og
med henvisning til en sakalt "pull-request" pa GitHub. | korte trekk er det ikke satt av nok plass til
Secure Partision Manager (SPM). Dette fgrer til feilmeldingen SPM Flash overflow ved kompilering.
(43) Filene som skal endres finner dere her: https://github.com/nrfconnect/sdk-nrf/pull/4103/files,
og de ligger lokalt pa din maskin her:

e (USERNAME) \ncs\v1.5.1\nrf\subsys\spm — Kconfig
e (USERNAME) \ncs\v1.5.1\nrf\samples\spm — prj.conf
e (USERNAME) \ncs\v1.5.1\nrf\samples\spm — prj_minimal.conf (denne skal opprettes)

Etter 3 ha ordnet opp i dette ma det kjgres en "CMake" for at kompileringen skal ta med de nye
konfigurasjonsfilene. Dette gjgres enkelt fra "Project" -> "Run CMake" dersom man blir informert om
at dette er ngdvendig. Det tok meg en ukes tid a finne ut av dette... Takk til Irene Sollie fra Nordic
som til slutt guidet meg gjennom denne prosessen!

Da bgr alt vaere klart for a laste kode pa kortet og se at man far kontakt med nRF Cloud. Det kan ta et
par minutter for kortet a koble seg opp, man kan fglge oppkoblingen i terminal i SEGGER. Det sendes
melding til nRF Cloud hver gang man trykker pa "Button 1" pa kortet, figur 16.

"Received™ : {

"state” :
"reported” : { 1 item

"message” : "Hello Internet of Things!

Figur 16 — Cloud message
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4.3  Kode for oppkobling

Vi starter kodeanalysen ved a se pa funksjonen main (figur 17), dette gir oss et godt bilde av hvordan
gangen i koden er. Du oppdager fort at det er mange nye makroer i koden, vi skal ga gjennom alle
sammen men jeg anbefaler uansett a besgke dem via "Go to definition". Det er ogsa en del
konfigurasjon i et slikt system, mange av funksjonene settes opp via et eget konfigurasjonsverktgy.
Dette finner man under "Project" -> "Configure nRF Connect SDK Project...".

Konfigureringsverktgyet er todelt, vi kommer bare til 3 ta for oss "menuconfig". Verktgyet brukes for
a aktivere eller deaktivere funksjonalitet i systemet, det kan veere praktisk & spke etter de aktuelle
funksjonen ved a benytte "Filter" boksen gverst i vinduet. Jeg har erfart at konfigureringsverktgyet
kan veaere ustabilt og henge seg opp under visse forhold, dette kommer jeg tilbake til litt senere.

Som standard er det LTE-M som benyttes som kommunikasjonsprotokoll for prosjektet

"cloud _client". Hvilken protokoll som benyttes endrer man i konfigureringsverktgyet. Sgk etter "LTE"
sa vil lista over protokoller dukke opp under "Select network mode". Igjen takk til Irene Sollie som
hjalp meg a fa konfigurert dette.

Jeg dro hjem til Ngttergy mot slutten av bachelorprosjekt-perioden. Etter at jeg kom hjem har ikke
NB-loT virket, jeg har derfor benyttet LTE-M for siste del av prosjektet. Dette skyldes trolig darlig
dekning i omradet jeg bor, men uten at jeg kan si det med 100% sikkerhet. Det utgj@r ingen praktisk
betydning for programmeringens del, men fglte allikevel det er greit a informere om dersom andre
har problemer med at NB-loT ikke fungerer optimalt.

vold main{void)
1
int err;
LOG_INF({"Cloud client has started™);

cloud_backend = cloud_get binding(CONFIG_CLOUD BACKEND);
__ASSERT(cloud_backend != NULL, "%s backend not found", CONFIG_CLOUD BACKEND);

err = cloud_init(cloud backend, cloud_event_handler);
if (err)
LOG ERR("Cloud backend could not be initialized, error: #d", err);

work_init();
modem_configure();

#if defined({CONFIG_CLOUD PUBLICATION BUTTON_PRESS)
err = dk_buttons_init(button_handler);
if (err)
LOG _ERR("dk_buttons_init, error: %d4", err);

et LOG_INF("Connecting to LTE network, this may take several minutes...™};
k_sem_take(&lte_connected, K_FOREVER);
LOG_INF("Connected to LTE network™);
LOG_INF({"Connecting to cloud");
k_delayed work submit({fconnect work, K _NO WAIT);
¥

Figur 17 — Cloud_Client - main
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LOG_INF er fgrste makro som dukker opp i main og benyttes for a loggfgre systemhendelser. Man
kan kategorisere hendelsene etter hva de er, om de er til informasjon (LOG_INF), advarsler
(LOG_WRN) eller feil (LOG_ERR). For & benytte funksjonen ma "logging/log.h" inkluderes og
LOG_MODULE_REGISTER(name, logging_level); ma kjgres for initialisering. | tillegg ma "Logger"
aktiveres i konfigurasjonsfilene. Mer om loggfgring kan leses her, merk at Logger APl inneholder
fullstendig liste over kategorier. (44)

__ASSERT brukes for a melde fra om feil, den sjekker om argumentet er usant, hvis det er tilfelle vil
den skrive ut definert feilmelding og sette systemet i en uendelig loop. Som med LOG_INF ma denne
ogsa aktiveres i konfig, sgk etter assert. (45)

Merk at makroer skilles fra funksjoner ved at de skrives med store bokstaver.

cloud_get_binding er en funksjon som gir en peker til den registrerte skylgsningen i systemet.
cloud_init initialiserer skylgsningen og gj@r all ngdvendig konfigurasjon. Fgrste parameter er peker til
skylgsningen og andre parameter er en peker til en "callback" funksjon. Det vil si en funksjon som blir
trigget nar det skjer en hendelse. Figur 18 viser eksempler pa hendelser. Vi vil ga naarmere inn pa
dette nar vi tar for oss sending og mottak av data om et lite gyeblikk.

work_init legger til to elementer i workqueue, disse har med skykoblingen a gjgre.
modem_configure konfigurerer modemet.

#if defined er i praksis #ifdef, men med stgtte for flere betingelser. Hvis betingelsene er forskjellig fra
NULL vil denne vaere sann.

void cloud event_handler({const struct cloud_backend *const backend,
const struct cloud_event *const ewvt,
void *user_data)

ARG _UNUSED{user_data);
ARG_UNUSED{backend);

switch (evt->type) {
case CLOUD_EWT_CONNECTING:
LOG_INF("CLOUD EVT CONNECTING");
break;
case CLOUD _EVT_COMMWECTED:
LOG_INF("CLOUD EVT CONNECTED");
cloud_connected = true;
break;
case CLOUD_EWT_READY:
LOG_INF("CLOUD EVT READY");
k_delayed work_cancel{&connect_work);
case CLOUD EVT DATA SENT:
LOG_INF("CLOUD EVT DATA SENT");
break;
case CLOUD_EVWT_DATA RECEIVED:
LOG_INF("CLOUD EVT DATA RECEIVED"):
LOG_INF("Data received from cloud: ¥.*s",
evit->data.msg.len,
log strdup(evt->data.msg.buf));
break;

Figur 18 — Cloud_Client - cloud_event_handler
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Jeg vil na beskrive gangen i oppkoblingsprosessen, dette innebeaerer 8 hoppe mellom kodelinjer i hele
main.c og jeg vil derfor henvise til nummer pa linjene fremfor a ta med kodesnutter direkte. main.c
finnes som vedlegg til denne rapporten, fila har navnet cloud_client.c i Programkode.zip mappen.

248 — Variabelen err brukes for returverdi fra funksjoner.
252 —cloud_backend er peker til skylgsningen.
253 — Hvis pekeren er NULL far vi feilmelding og systemet settes i uendelig loop.
256 — Funksjonen cloud_init blir kjgrt, dersom err ikke er NULL har det har oppstatt en feil.
Denne vil i sin tur starte cloud_event_handler som ser etter hendelse fra skylgsning.
262 — Funksjonen work_init blir kjgrt.
152 — cloud_update_work_fn blir initialisert til en forsinket workqueue.
153 — connect_work_fn blir initialisert til en forsinket workqueue. (46)
263 — Konfigurerer modemet.
208 — Her kunne man satt opp PSM (Power saving mode) ved behov.
223 — Dette blir funksjonskall etter funksjonskall for oppsett av LTE forbindelsen.
Ite_handler blir etterhvert kalt.
168 Semaforen Ite_connected blir frigitt.
266 — Konfigurer button1 i ekstern fil.
240 — Ved knappetrykk blir adressen til funksjonen cloud_update _work lagt i workqueue.
273 — Venter til semaforen er frigitt fra kodelinje 168. Nar den blir det vil LTE oppkoblingen veere
vellykket og programmet kan fortsette.
278 — Adressen til connect_work blir lagt i workqueue.
33 — Denne vil sjekke om utviklingskortet er koblet til skytjenesten, denne funksjonen vil g i
loop til oppkoblingen er vellykket.
85 — cloud_event_handler sjekker status til skyoppkobling.
103 — Oppkoblingen er vellykket og connect_work slettes fra workqueue (linje 33).
238 — Denne blir trigget ved knappetrykk pa buttonl.
241 — Legger adressen til cloud_update_work til workqueue.
56 — Gjgr klart for sending av data, CONFIG_CLOUD_MESSAGE er definert i Autoconfig.h ***
67 — Sjekker at den definerte skytjenesten er "NRF_CLOUD".
73 — cloud_send sender data til skyen, parameter nr2 er adressen til meldingsbufferet.
Tilbake til 238 og venter pa nytt knappetrykk.

*** Dette er strukten som blir brukt til sending av data. Den bestar av QoS (Quality of Service), en
melding og lengden av meldingen. Data blir sendt til skyen nar funksjonen cloud_send blir kjgrt.
CONFIG_CLOUD_MESSAGE settes opp i konfigurasjonsverktgyet og er en streng pa JSON format.

Hvis vi ser pa teksten fra konfigureringsverktgyet sammenliknet med den fra Autoconf.h ser vi at det
erlagttil'\'fgralle'"". Dette er for a fortelle kompilatoren at neste tegn ikke er avslutningen pa
tekststrengen.

Konfigurasjonsverktgy: {"state":{"reported":{"message":"Hello Internet of Things!"}}}
Autoconf.h: "{\"state\":{\"reported\":{\"message\":\"Hello Internet of Things!\"}}}"
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Jeg eksperimenterte med egne tekststrenger for & se om jeg kunne fa sendt temperaturdata til riktig
vindu i nRF Cloud, underveis kom jeg i skade for a legge inn fglgende i konfigurasjonsverktgyet.
“{\“appld\”:\“Temp\“’\”data\":\"21\"}"

Dette resulterte i feilmeldingen vist i figur 19, eneste valg er "OK" og dette gjgr at systemet laser seg.
Man kan da ikke lengre apne verktgyet fordi syntaksen er feil... | Autoconf.h har vi na strengen.
#define CONFIG_CLOUD_MESSAGE "\"{\\\"appld\\\":\\\"Temp\\\",\\\"data\\\":\\\"22\\\"A\""
Vakkert, ikke sant?

L

Cloud Client Sample Settings
B Sets the custom message published periodically to cloud "{\"appIid\":\"Temp'
B Sets how often the custom message should be published to cloud, in seconds 10
Cloud Publication Trigger
O Sets sequential publication to cloud s¢ @ javascript Alert - w ITION_INTERVAL option

Zephyr Kernel

Modules ':6:' SyntaxError: Unable to parse JSOM string
nrf (C:Usersaudunncsv1.5.1nrf)
Nordic nRF Connect
Networking

Application protocols
nRF Cloud library
W Size of the buffer for MQTT library. 256

General Kermnel Options

Other Kernel Object Options
B Maximum number of in-flight asynchronous mailbox messages 10

[] Show Names []Show Symbols
[ Show All

Figur 19 — CONFIG_ CLOUD _MESSAGE

Sa hvordan fungerer "Configure nRF Connect SDK Project" og hvordan er koblingen til Autoconf.h.
Hvordan far man dette i gang igjen? Lgsningen skulle bli 3 bruke WinMerge for a markere filer som
var forandret fra det opprinnelige prosjektet. Fgr jeg kom frem til denne Igsningen ble det forsgkt a
benytte sgkefunksjonen i Windows for a finne "CONFIG_CLOUD_MESSAGE", men det skulle vise seg
at Windows hverken sgker i filer uten "extensions" eller filer uten navn. Disse filene er relevante:

e (USERNAME) \ncs\v1.5.1\nrf\samples\nrf9160\cloud_client — Kconfig
o Denne blir brukt for innledende konfigurasjon og oppsett av konfigurasjonsverktgyet.
o (USERNAME) \ncs\v1.5.1\nrf\samples\nrf9160\cloud_client\build_nrf91(..)\zephyr — .config
o Nar konfigurasjonsverktgyet apnes blir konfigureringen lastet inn fra denne fila. Det
er denne fila som blir brukt for a8 generere Autoconfig.h
e (USERNAME) \ncs\v1.5.1\nrf\samples\nrf9160\cloud_client\build_nrf9160dk_nrf9160ns
\zephyr\include\generated — Autoconfig.h
o Dette er resultatet av kompileringen.

Lgsningen pa problemet var @ endre strengen i .config med fglgende.
CONFIG_CLOUD_MESSAGE = "{\"appld\":\"Temp\",\"data\":\"21\"}"

19



5. Kode —motta data fra sky

I mange tilfeller er det praktisk @ kunne gi kommandoer eller beskjeder til et system som er koblet pa
nettet. For eksempel vil du ha en statusoppdatering eller kanskje du vil styre en lampe. Vi skal i dette
kapittelet se pa hvordan man kan sende en melding fra nRF Cloud og tolke den pa kortet. Som nevnt
tidligere kreves det at man sender meldinger pa JSON format fra nRF Cloud.

Visaifigur 18 pa cloud_event_handler som er en callback-rutine fra Ite_handler. Denne blir kjgrt
hver gang det skjer en hendelse i cloud-backend. Dersom vi mottar en innkommende melding vil den
tilhgrende hendelsen veere "CLOUD_EVT_DATA_RECEIVED". Meldingen blir da skrevet ut til terminal.
For a tolke denne meldingen og utfgre en handling trenger vi en JSON parser. Min far, Tord Brabrand,
har jobbet med noe tilsvarende tidligere og hadde en enkel parser som kunne tilpasses til dette
bruksomradet. Han har bistatt meg med tilpasning og implementasjon i denne delen av oppgaven.
Jeg kommer ikke til & ga i detalj pa hvordan parseren er bygget opp da det ikke er direkte relevant til
etterarbeid for denne rapporten. Man vil fort ha behov for en mer universell parser som kan ta alle
typer meldinger. (47)

Malet med denne delen av oppgaven vil vaere a kunne kontrollere de fire lysdiodene pa kortet samt
innhente sensordata. Som nevnt tidligere har ikke utviklingskortene til Nordic innebygde sensorer, sa
vi vil derfor benytte simulerte sensorverdier for denne demoen. Driverbiblioteket til Nordic
inneholder en simulator som kan gi simulerte verdier til de funksjonskallene man vanligvis henter
sensordata fra, dersom det aktuelle kortet ikke har sensorene man forsgker a benytte. JSON parseren
er tilpasset for & fungere til dette bruksomradet. Kildefiler til dette prosjektet ligger som vedlegg til
rapporten, se "cloud _client_data_received.zip". For 8 komme i gang med dette prosjektet kopierer
man inn filene til mappen

e (USERNAME) \ncs\v1.5.1\nrf\samples\nrf9160\cloud_client\src

Sa ma vi fortelle kompilatoren at vi gnsker a ha med json_command_interpreter.c og
json_command_interpreter.h, dette gjgres ved a legge dem til i CMakelList.txt, ett niva opp fra der du
la inn prosjektfilene. | denne fila legger du inn de nye filene pa samme mate som main.c er lagt inn.
Nar dette er gjort ma CMake kjgres og prosjektet vil vaere kompilerbart.

For at prosjektet skal fungere ma man inn i konfigureringsverktgyet for a aktivere Sensor Driver (spk
etter sensor). Trykk konfigurer. Sa ma vi legge til Sensor simulator, dette vil dukke opp etter at
konfigureringen av Sensor Drivers er kjgrt. Etter dette ma du aktivere Sensor simulator trigger. Du ma
altsa inn i konfigurasjonsverktgyet tre ganger for a konfigurere dette.
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Jeg vil nd begynne a snakke om selve koden i prosjektet. For a ikke gjgre dette alt for omfattende vil
ikke absolutt alt bli forklart her. Tanken er at kommentarene underveis i koden er forklarende pa
egenhand og at jeg derfor konsentrerer meg om a forklare tankegangen bak oppbygningen. Denne
koden er en utvidelse av koden i forrige kapittel, jeg vil derfor fortsette der jeg slapp og na forklare
mottak av data og til en viss grad hvordan dataene blir tolket.

cloud_event_handler vil bli kjgrt nar systemet mottar en melding fra skyen og vil i sin tur kjgre
case CLOUD_EVT_DATA_RECEIVED som frigir semaforen json_received. Koden vist i figur 20 vil bli
kjgrt nar semaforen er frigitt. k_sem_take vil suspendere main-lgkka inntil semaforen er tilgjengelig.

while (1) // Main-loop to handle received json command strings:

{

k_sem_take(&json_received, K_FOREVER);

LOG _INF("JSON message receiwved: ¥s\n", rx buffer);
ParselsonString(rx_buffer);
HandleUpdatedAttibuteValues();

if (get_command_received) // If a "get" command is received ..

{

sendAttributestatusToClouwd(); // the requested value will be send to cloud
get command received = FALSE;

448 1

Figur 20 —JSON mottatt

Dette vil sa starte funksjonen ParselsonString som plukker ut teksten eller ordene fra JSON
meldingen. Denne vil sortere ut hva som er topic og hva som er nytteverdien (payload) i hver
melding. Dette blir gjort i den eksterne fila json_command_interpreter.c. Nar dette er kjgrt vil
programmet fortsette med funksjonen HandleUpdatedAttributeValues som gar gjennom de ordene
som forrige funksjon plukket ut og sjekke disse opp mot en liste med forhandsdefinerte attributter.
Denne vil igjen kalle funksjonen HandleNewValue som gjgr handlinger basert de data parseren har
behandlet. Etter dette vil vi komme tilbake til main-lgkka. Hvis get_ command_received er forskjellig
fra NULL vil funksjonen SendAttributeStatusToCloud bli kjgrt.

Jeg har forhandsdefinert fglgende attributter i
systemet (figur 21), disse kan slas av eller pa ved a y
sende "ON" eller "OFF" samt O eller 1 til systemet. #define a_TEMP_REPORTING

Ved & skrive {"GET" : "ALL"} kan man f4 status p3 #define a_LED1
#define a_LED2

Attribute table:

[, QN < RO N T S v

?I!e attributter i syster'n'et. Parseren var Iagt opp til sdefine a LED3
a ikke veere case-sensitiv, dermed har det ikke noe #dafine 3 LED4
a si hvordan du skriver meldingene til dette #define a GET
systemet. TEMP_REPORTING styres pa samme Figur 21 - Attributter

mate som lysdiodene, nar denne er aktivert vil det
sendes simulerte temperaturdata til skyen hvert 5
sekund. Figur 22, 23 og 24.
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& Terminal A

"Received™ : { 1 ifem

"TEMP_REPORTING"™ :

“"Received™ : { 6 i
“"TEMP_REPORTING™ :
“LED1"

“LED2"
“LED3"
"LED4"

"GET™ = "

{"LED1" : "ON"} Send Clear

Figur 22 — nRF Cloud

5.1 Sensor avlesning

Det siste vi skal ta for oss er hvordan man leser av en sensor. Vi starter med a fa dette opp d g i
prosjektet minimal. Det er ikke ngdvendig at du har noe tidligere konfigurering i dette prosjektet
utenfor den vanlige konfigureringen prosjektet har nar det lastes. Nok en gang kreves det at vi gjgr
en del konfigurering. Sensor simulator trigger ma aktiveres, dette innebaerer at du ma inn i
konfigureringsverktgyet "Project" -> "Configure nRF Connect SDK Project..." tre ganger. Sgk etter
sensor for a fa opp valgene. | tillegg ma Newlib C library —> Build with newlib-nano C library
konfigureres. Figur 25 viser koden for sensoravlesning, data fra sensoravlesningen blir skrevet ut til
terminal.

"TEMP_REPORTING™ : '

"LED1" : 2a]

"LED2" : U wvwew $wrwe
“LED3"
“LED4™

. "ALL"

Received™ : { 3 items

“appId” : "TEMP" ! | i |
22:06:16 22:06:51 22:07:26 22:08:26
“data™ :

Figur 23 — Temperatur

"messageType”™ @ "DATA"

Figur 24 — TEMP_REPORTING

22



f¥ - Read sensor data ----- *f
#include <zephyr.h>
#include <drivers/sensor.h:

void main{void)

1
int err;
const struct device *dev;
struct sensor_value data;
double value = 123.8;
struct k_spinlock lock;
k_spinlock key t key;

dev = device get binding(CONFIG_SENSOR_SIM DEV _NAME);
__ ASSERT(dew, "Could not get device %s\n", CONFIG_SENSOR_SIM DEV_NAME);

while (1)
{ J//Fetching sensor value from channel to internal buffer
err = sensor_sample_fetch_chan({dev, SENSOR_CHAN_AMBIENT_TEMP);
if (err)
printk("Failed to fetch data from ¥s, error: ¥d", CONFIG_SENSOR_SIM_DEV_NAME, err);
//Collecting data from internal buffer
err = sensor_channel_get(dev, SENSOR_CHAN_AMBIENT_TEMP, &data);
if (err)
printk("Failed to fetch data from %s, error: ¥d", CONFIG_SENSOR_SIM_DEV_NAME, err);
else

1

key = k_spin_lock(&lock); //Ensure that this thread is not interrupted
value = sensor_value to_double(&data);
k_spin_unlock(&lock, key); // ... until here

h

printk("Temperature = %d\n", (int)value);
k_sleep(K_SECONDS(5));

EREE T Configuration ----- =t
J//sensor Driver — Sensor simulator - Sensor simulator trigger
48 //Newlib C library - Build with newlib-nano C library

Figur 25 — Sensoravlesning

Forste del av koden er tilsvarende til ting vi har sett pa fgr, men sa kommer vi til Spinlock. Spinlock
brukes for a sikre at et kodeavsnitt ikke blir avbrutt. k_spinlock key t er en strukt som er definert i

en ekstern fil. Ved se pa "Go to definition" ser vi at den finnes i spinlock.h og er en typedef strukt
z_spinlock_key k_spinlock_key t;

Funksjonen sensor_sample_fetch_chan brukes for a lese ut sensorverdier og lagre disse til et internt
buffer. Videre vil sensor_channel_get gi oss verdien fra dette bufret for den sensoren vi forespgr.
Dette bufret er todelt med verdier for tallet foran og bak komma. Man benytter funksjonen
sensor_value_to_double for 3 konvertere disse til et dobbelt presisjon "floating point" tall. Vi ser i
eksempelet her ma man vaere sikker pa at verdien i data ikke blir endret underveis i prosessen med a
sla dem sammen. Det er derfor viktig a8 benytte funksjoner som spinlock.
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Det er denne koden som er implementert i eksempelet med skytilkobling. Temp_reporting skrur av
eller pa den rutinen som henter sensordataene. Funksjonen send_temperature_thread kjgres av en
thread og vil etter initialisering kjgres konstant. while(1) vil alltid ga i loop med intervall pa
TEMP_REPORTING_INTERVAL. Dersom temp_reporting er satt vil rutinen kjgre kode tilsvarende den i
figur 25. Den vil til slutt kalle MakeJsonTemperatureString som tar temperaturen og pakker den inni
en JSON streng som tolkes til temperatur i nRF Cloud.

Nar koden startes og LTE forbindelsen er opprettet vil LED1 tennes, LED2 tenner nar oppkoblingen til
skytjenesten er vellykket. Det gj@r det enkelt 3 fglge prosessen underveis. Figur 24 og figur 25 viser
resultatet nar TEMP_REPORTING er satt til 1 (ON). Funksjonen SendTemperatureToCloud kaller
cloud_send som gjor selve publiseringen av meldingen.

5.2  Oppsummering

Dette er i bunn og grunn alt du trenger 3 vite for 8 komme i gang med loT pa utviklingskort fra Nordic
Semiconductor som kjgrer Zephyr RTOS. Vi har sett pa hvordan de grunnleggende prinsippene med
Threads og Workqueue fungerer, samt hvordan en lysdiode styres. Vi har fatt etablert kobling til
skyen og sett pa hvordan kommunikasjonsflyten gar. Vi har ogsa vaert inne pa hvordan kortet kan
kontrolleres via skyen. Ved a lese mer om button_init finner man ut av hvordan funksjoner trigges fra
knappetrykk. Selv om det ikke er noen perfekt kode kan JSON parseren utvides for bruk i flere
bruksomrader.

Vi har ogsa veert innom konfigurering og sett pa hvordan man benytter konfigureringsverktgyet for a
aktivere ytterlige funksjoner i koden. Det har blitt presentert en del nyttige artikler som forklarer
temaer det kan vaere lurt a lese mer om. Jeg vil avslutningsvis komme med noen konkrete ting man
kan se videre pa.

Vi har dessverre ikke brukt sa mye tid til a snakke om Bluetooth, noe av grunnen til dette er at det er
et stort fagfelt i seg selv. | tillegg har nRF9160 blitt brukt for 3 demonstrere prosjektet, denne
mikrobrikken har som sagt ikke stgtte for Bluetooth. Dersom vi skulle fatt i gang et Bluetooth-
prosjekt matte vi fatt til en kobling mellom nRF52840 og nRF9160 pa utviklingskortet.

Dessverre har jeg ikke lyktes i prosessen med a migrere prosjektet over til a kjgres pa Thingy:91. Jeg
har forsgkt a konfigurere prosjektet etter dette tipset for a fa generert app_signed.hex:
https://devzone.nordicsemi.com/f/nordic-g-a/58024/no-app_signed-hex-in-build-folder

Og jeg har fulgt denne veiledningen for a klargjgre og laste kode pa Thingy:91:
https://infocenter.nordicsemi.com/index.jsp?topic=%2Fug nc programmer%2FUG%2Fnrf connect
programmer%2Fncp programming thingy91.html

Til tross for dette far jeg feilmeldingen "MCUboot DFU failed" nar prosjektet forsgktes lastet til
kortet. Jeg har derimot lyktes med & laste "asset_tracker"-prosjektet pa denne maten. Det kan virke
som konfigureringen er feil i "Cloud_client" for a tillate programmering pa denne maten. (48) (49)
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b. Etterarbeid

Vi har na satt opp et system med fa muligheter for utvidelser. nRF Cloud er ingen ideell Igsning for et
generelt loT sensornettverk. Vi har ogsa kun simulerte sensorer som gir oss unyttige verdier i et reelt
system. Derfor ville det veere spennende a laere mer om AWS loT (Amazon Web Services) og ta i bruk
deres lgsninger for MQTT broker og web applikasjoner. Node-RED er et grafisk konfigureringsverktgy
man kan bruke for oppsett av sensornettverk. (50) (51) (52)

JSON parseren som ble presentert i forbindelse med denne rapporten er ogsa noe man ma se videre
pa. Det finnes en JSON parser i asset_tracker prosjektet, men fgrsteinntrykket var at det var over mitt
ambisjonsniva a finne ut av pa den tiden jeg hadde til radighet. Jeg har heller ikke brukt veldig mye
tid pa a Google etter andres Igsninger pa slike parsere, sa her gir jeg fra meg stafettpinnen uten
videre tips.

Videre ville det veert artig a utvidet systemet med Bluetooth for & ha flere sensorer over et omrade
som kan jobbe sammen i nettverket. Nordic har lagt opp til at man kan benytte Bluetooth MESH fra
BLE standarden, og med dette kan man ha lang avstand mellom den ytterste noden i systemet og
sentralen. Dette kan for eksempel benyttes i jordbrukssammenheng da man kan plassere flere
sensorer ut pa et jorde, og som kan transportere data over stgrre avstander. Bluetooth MESH bruker
mer strgm enn en vanlig BLE tilkobling, derfor bgr man se pa mulighetene for 3 ha noen noder med
stgrre batteri/energihgsting som kan vaere mellommenn, mens sensorene ellers bare sender et pling
nar de har noe a melde. (53)

Jeg har heller ikke gatt opp veien for a finne ut hvordan man konfigurerer opp et nytt tomt prosjekt i
SEGGER. Det ville vaert ggy a lagt ut et eget kretskort med mikrobrikkene fra Nordic, og startet fra
grunn av med 3 sette opp all ngdvendig konfigurering. Hvor omfattende dette er vet jeg ikke, det kan
veere nyttig a ta for seg disse to tradene fra DevZone for & ha et sted a starte.

e Devicetree konfigurering:
o https://devzone.nordicsemi.com/f/nordic-q-a/47990/device-tree-configuration-
guidelines
o https://devzone.nordicsemi.com/nordic/nrf-connect-sdk-
guides/b/peripherals/posts/adding-a-peripheral-to-an-ncs-zephyr-project

e Amazon Web Services
o https://aws.amazon.com/iot/
o https://www.youtube.com/watch?v=T Cfepvd2hw
e Mosquitto MQTT
o http://www.steves-internet-guide.com/mosquitto pub-sub-clients/
e Node-RED
o https://nodered.org/
o https://www.youtube.com/watch?app=desktop&v=GeN7g4bdHiM
e Bluetooth Low Energy
o https://www.bluetooth.com/bluetooth-resources/intro-to-bluetooth-gap-gatt/
o https://learn.adafruit.com/introduction-to-bluetooth-low-energy/gatt

e Bluetooth prosjekt
o https://circuitdigest.com/microcontroller-projects/nordic-nrf52-development-kit-
measuring-temperature-and-humidity-using-ble
o Koble til LCD display
o https://devzone.nordicsemi.com/nordic/nrf-connect-sdk-
guides/b/peripherals/posts/lvgl-on-a-tft-lcd-display-with-the-nrf9160-dk
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7.  Refleksjon

Dette har veert et utrolig spennende og laererikt prosjekt som har gitt meg en god innfgring i loT og
sanntidsprogrammering. Det er ingen tvil om at det var tungt & komme i gang med systemene, men
etter en strevsom start begynte ting a falle pa plass og prosessen ble mer og mer morsom etter hvert
som tiden gikk. Jeg ble advart pa forhand om at det var en forholdsvis bratt laeringskurve for dette
systemet, men at nar det fgrst lgsnet ville det ga fort videre. Det var litt skuffende a se hvor fa
nybegynner-guider det finnes innenfor dette tema, men jeg haper at denne rapporten vil veere til
hjelp for andre som gnsker 8 komme i gang.

Det ma sies at det har veert en god del frustrasjon underveis. Det er slettes ikke alltid like lett a skaffe
oversikt over de temaene man prgver 3 sette seg inn i, og nar man fgrst begynner a grave er det bare
toppen av isfjellet man har funnet. | moderne embedded programmering blir det vanskeligere og
vanskeligere a lage systemer fra bunnen av. Man far derfor aldri fullstendig oversikt og man ma bare
stole pa at de som har utviklet driverne har gjort en god jobb.

Konfigurasjon er noe jeg har begynt a fa oversikt over, men det er fortsatt usikkerhetsmomenter
knyttet til dette. Dessuten er hele systemet med Devicetree og hvordan man skulle definert pinout
for et eget kretskortutlegg noe som det gjenstar a finne ut av.

Potensialet for denne typen teknologi, og de mikrobrikker som Nordic har designet gjgr at det uten
tvil er verdt & bruke tid pa dette. Jeg er fristet til 3 si at det kun er fantasien som setter grenser for
hva man kan utvikle nar man har kontroll og oversikt over et slikt system.

ESP32 er et konkurrerende system, men som forelgpig ikke tilbyr LTE eller GPS teknologier. Ellers er
dette mye brukt i DIY (gj@r det selv) sammenheng, sa tilgangen pa guider og eksempelprosjekter er
mye bedre. Det kan vaere verdt a lese mer om dette for systemer der strgmforbruk og mangel pa LTE
ikke er sa avgjgrende. (54)

Dette er absolutt et tema jeg vi anbefale andre 3 sette seg inn i, og jeg haper at jeg med denne
rapporten har gjort det litt mer overkommelig.
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8.  Kjekt a vite
8.1 SPlogl2C

SPI og 12C er kommunikasjonsprotokoller brukt for kommunikasjon mellom en master og opptil flere
slaver. Det kan typisk vaere mellom en microkontroller og andre integrerte kretser. Felles for begge
protokollene er at det kreves felles klokke og jord for & overfgre data. SPI baserer seg pa "full-duplex"
med 2 datalinjer i motsetning til "halv-duplex" pa 12C der kommunikasjonen bare gar over en
datalinje. Se figurer. I SPI har man SS (Slave Select) som forteller hvilken slave master gnsker a snakke
med, masteren ma ha en SS pinne for hver slave som skal kobles til. 12C pa sin side starter hver
sending med adressen til den slaven som man gnsker 8 kommunisere med. SPI stgtter ogsa langt

hgyere bandbredde enn det 12C stgtter, —p o] scik
gjerne over 10megabit/sekund. (55) (56) SP| MOS| B MOS 5P|
Master MISO |g—— | MISO Slave
55 p S5

8.2 UART Figur 26 — SPI

Universal asynchronous receiver-transmitter (UART) er hardware for asynkron seriell kommunikasjon
mellom to enheter. Typisk kan det vaere mellom en microkontroller og en sensor, mellom to
microkontrollere eller mellom en datamaskin og en microkontroller. RS-232 (12v) og RS485 (5v) er
mye brukte i UART sammenheng. (57)

8.3  Nettverksstandard - OSI modellen

Open system interconnection (OSI) modellen beskriver hvordan de ulike protokollene i et
datanettverk fungerer sammen. Nettverket er delt opp i fem lag som hver har ansvaret for sin del av
kommunikasjonen. Siden et nettverk er svaert komplekst har det veaert praktisk a dele det opp i ulike
deler, hvert lag trenger bare a forholde seg til APlet til laget under seg. (58) Oppdelingen er som
folger:

5. Applikasjonslaget
Programvaren som gnsker 8 kommunisere sammen.
HTTP, FTP, MQTT

4. Transportlaget
Palitelig overfgring av datasegmenter mellom to punkter i nettverket.
Korrigere eventuelle feil i underliggende lag.
TCP protokoll, UDP protokollen

3. Nettverkslaget
Meldingshandtering pa et multi-node nettverk.
Data adresseres til riktig mottaker i riktig rekkefglge.
IP protokollen

2. Datalinklaget
Overfgring av data mellom to noder pa det fysiske laget.
Fysisk adressering, (MAC adresser).
Ethernet protokoll

1. Fysisklag
Overfgring av bitstrgm over et fysisk medium.
Elektriske kabler, fiberoptikk og radiobglger
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